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The following guidelines have been developed to assist faculty and students in developing PowerPoint lectures. 
These procedures will help avoid some of the common technical and copyrighted materials pitfalls regarding 
use of PowerPoint lecture files that are posted to the Blackboard system. 
 

        
File Extension: 
Please be sure the file name of your PowerPoint presentations to be posted in Blackboard consists of letters and 
numbers, no spaces, and are not longer than 8 characters.  Also, before uploading a document, check to be 
sure it has the appropriate extension at the end (such as .doc (Word), .ppt (Powerpoint), .pdf (Adobe 
Acrobat), or .jpg, gif, or .tiff (picture file).  Otherwise, students may not be able to open the file. (This is 
primarily a problem with non-Windows based computers.)  
 

Examples of proper file nomenclature: 
o Lecture1.ppt (preferred file name) 
o Lecture_1.ppt (acceptable file name- not preferred) 
o Lecture 1.ppt (unacceptable because of spaces) 

 
Office 2007 & Windows Vista Users: 
Please be aware that Office 2007 uses a new file format when working with new Microsoft Office documents.  
The new format appends an “x” to the end of file extension.  For example a Word document in earlier versions 
used a .doc extension whereas Word 2007 uses a .docx extension.  The same is true of PowerPoint, Excel, and 
other Office 2007 Applications.  Examples include: .pptx (previously .ppt) and .xlsx (previously .xls).  Someone 
using a version of Office earlier than 2007 will be unable to open one of these new files in the new format 
unless they have installed an Office 2007 viewer or the “Microsoft Office Compatibility Pack for Word, Excel, 
and PowerPoint 2007 File Formats” (downloadable from Microsoft) add-in installed.  To avoid this issue you 
can save your files in the older Office 97-2003 format which can be opened with any version of Office 97 or 
later.  Please note this information is true of using Office 2007 on either Windows XP or Windows Vista. 
 
To save an Office 2007 document in the older file format (97-2003); do the following: 

• Click on the Office Button (top left corner) 
• Hover your mouse pointer over Save As 
• Select Word 97-2003 Document 

 
Alternate Method: 

• Click on the Office Button (top left corner) 
• Click on Save As 
• Under “Save As Type” select “Word 97-2003 Document (*.doc)” 
• Click Save 

 
 

 File Nomenclature 

 Overview 



 
 

Health Informatics Page 3 of 7 April 2007 

 
Guidelines for Developing PowerPoint Lectures 

 
 

 
For Lecture PowerPoints: 
Under the fair use provisions of copyright law you may include some limited copyrighted material in a 
PowerPoint presentation.  If you have not obtained copyright permission it is strongly recommended that 
you do the following. 
 
• The source of all items, whether permission has, or has not, been obtained must be included on the slide.  
• Whenever possible use objects (figures, tables, etc.) from the required course textbooks.  Indicate the 

source of the object (i.e., figure number) so that students may later reference and review the object on 
their own. 

 
 

For Posting PowerPoints on Blackboard: 
• If a PowerPoint presentation is posted on Blackboard, any items (figures, tables, etc) within the 

presentation that would violate copyright laws must be removed from the posted materials. An 
alternative to removing material is to post a non-printable and non-copyable version.   

• Additional copyright info is on the library website http://library.uchc.edu/copyright/ and under 
the “Resources” tab in Blackboard.  

 
 

 
•  Refrain from integrating video clips in your presentation. Such integration is not compatible across all 

computing platforms and causes the presentation file to fail on many computers, frustrating your 
audience. If you need to integrate video in your presentation, post your video clip on a web server and 
place a hyperlink within the slide that will open the clip in a web browser. This will help ensure your 
presentation operates smoothly on all users’ computers. Faculty, please consult Faculty Instructional 
Technology Services at X2573 or nicosia@uchc.edu for more information on integrating video clips in 
your Powerpoint presentation.  Students, please consult Computer Education Center staff at X8870 or 
bensmith@uchc.edu or mainelli@uchc.edu for more information on integrating video clips in your 
PowerPoint presentation. 

 
• The file format of images can present some problems in PowerPoint presentations.  For best results it is 

recommended that you use the JPEG format when inserting images into your PowerPoint presentation.  
The image format that causes the largest number of issues is TIFF image format.  TIFF files can cause 
some cross-platform compatibility issues rendering them un-viewable when copied and pasted into 
PowerPoint presentations (please see the next bullet about properly inserting pictures into your 
presentation to avoid this issue).  Another issue with TIFF files is that the file size is typically larger than 
a JPEG which will increase the overall size of your presentation significantly.  Finally some issues have 
arisen with 16-bit versions of TIFF files which need to be converted over to an 8-bit format.  If possible 
try to avoid the TIFF format (mainly due to the large file size and cross-platform problems) in favor of 
the JPEG format. 
 

 Using Copyrighted Materials or Library License Materials 

 Integrating Graphics and Video Within Your Presentation 
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• When inserting images into a PowerPoint presentation use PowerPoint’s insert feature rather than 
“dragging & dropping” or “copying & pasting” images into a slide.  This will cut down on the overall 
size of the PowerPoint presentation as PowerPoint compresses images that were inserted using the insert 
feature.  This will also offer cross platform viewing of presentations.  For example a presentation created 
on a MAC will be viewable on a PC and vise-versa.  

  
Here is how to properly insert an image into PowerPoint: 

 
o Click on the Insert menu and select Picture and then select From File 
o Locate your image to be inserted and select it 
o Click on Insert 

 
 

 
When posting PowerPoint presentations on Blackboard set the background color of the slides to white and the 
text color to black.  Note that changing the slide design to a white background and black text will not change the 
images in the presentation – only the text.  You may keep the original slide design for your lecture; however, 
the copy you post in Blackboard must be black and white to ensure cross-platform compatibility.   
 

Follow these steps to convert your slides to a white background with black text: 
 

o Open your presentation in PowerPoint 
o Click on the Format menu and select Slide Design 
o Under Slide Design make sure Design Templates is selected 
o Hover your mouse over the design that has a black & white color scheme to it (called the default 

design) – once your mouse hovers over it a pull down menu will appear giving you the option to 
apply this design to all slides – “Apply to all slides” 

o You will see all of the slides now appear with a white background and black text 
 
 
 

 
Another method of distributing your presentation is to convert it to a PDF file.  Adobe Acrobat creates files in a 
universal Portable Document Format (PDF). PDF files are universal across all platforms and are a reliable way 
for all users to access your presentation. If you do not have access to a version of Adobe Acrobat that is capable 
of creating a PDF file, faculty, please contact Faculty Instructional Technology Services at X2573 or email 
nicosia@uchc.edu; and students, please contact Computer Education Center staff at X8870 or email 
bensmith@uchc.edu or mainelli@uchc.edu    
 
Instructions are listed below on how to create a PDF out of your presentation. 
 
 

 Slide Design 

 Creating An Adobe Acrobat (PDF) File Of Your Presentation 
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To convert your presentation, follow these simple steps: 
 

o Go to the File menu and select Print 
o Under Printer Name select Adobe PDF 
o Under Print What select Handouts 
o Under Slide Per Page select the number of slides you want to appear on each page (4 – 6 offers 

the best results) 
o Under Color/grayscale select Grayscale 
o Click Ok 
o Name your file and select where to save it 
o Your PDF file will be created 

 
 

 
You can secure a PDF file so that it cannot be printed or copied.  This helps to support “Fair Use” of 
copyrighted material that you use on a one-time basis because it eliminates further distribution and insures that 
the material is used just for those students registered in your class on this one occasion.  Instructions are 
provided above for converting your PowerPoint presentation to a PDF file: Creating an Adobe Acrobat (PDF) 
File of Your Presentation.  
 
 

To secure the document so that it cannot be printed or copied, follow these steps: 
 

o Create your PDF file and open it in Adobe Acrobat Pro 
o You will need to now get into the Security properties of the document 

 Click on the File menu and select Properties (or Document Properties) 
 Click on the Security tab 

o Under Security Method select Password Security 
o Under Permissions check Restrict editing and printing… 
o Under Change Permissions Password enter a password 
o Under Printing Allowed make sure it is set to None 
o Make any other security adjustments you would like 
o Click Ok 
o When prompted re-enter your password and click Ok 
o Click Ok to get out of the Document properties 
o Save your document – please note the security settings will not be applied to the document until 

you save it 
o You can test to make sure the security settings were applied by saving the document and then 

trying to print it (the print function should be grayed out and inaccessible) 
 
 
 
 
 

 Creating A Secure Adobe Acrobat (PDF) File Of Your Presentation 
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How do I avoid creating a document that someone will be unable to open? 
• Make sure you stick to the appropriate naming conventions and appending appropriate file extensions to 

the presentation.  You can view File Nomenclature on page 2 for more information on appropriate 
naming conventions. 

• Try to use JPEG images when inserting images into your presentation.  If possible avoid using TIFF 
files as these can cause cross-platform compatibility issues.  Also make sure to insert images into your 
presentation using the appropriate steps (not cutting & pasting into PowerPoint).  For more information 
please see Integrating Graphics And Video In Your Presentation on page 3. 

• If you are using Office 2007 make sure you save your files in an Office 97-2003 file format so that 
people using older versions of Office can open your presentation.  More information can be found on 
page 2 under File Nomenclature. 

 
How can I keep the file size of my presentation as small as possible? 

• Use JPEG images whenever possible.  JPEG images automatically compress the image to reduce the file 
size.  More information can be found on page 3 under Integrating Graphics And Video In Your 
Presentation. 

• Microsoft Office also compresses images when they are inserted into PowerPoint using the appropriate 
steps.  More information on inserting images into a PowerPoint presentation can be found on page 4 
under Integrating Graphics And Video In Your Presentation. 

• When posting your presentations in Blackboard you can reduce the size by removing the “fancy” 
backgrounds from your presentation.  For more information please see Slide Design on page 4. 

 
What will happen if I forget to add the .ppt extension to the end of my PowerPoint presentation? 

• The largest issue you will run into is that individuals will not be able to open your presentation.  When 
you save a PowerPoint presentation on a Mac you should make sure that the “Append File Extension” 
checkbox is checked in the Save window.  If you don’t do this the extension may get cut off and another 
computer trying to open the file may not recognize it as a valid file format and won’t open it. 

• Also please make sure that you name the file appropriately.  If the name is too long another computer 
and/or Blackboard may truncate the file extension and possibly making the format unrecognizable by the 
viewer’s computer.  More information can be found on page 2 under File Nomenclature. 

 
How should I handle copyrighted material in my presentations? 

• For information regarding copyright please see “Using Copyrighted Materials or Library License 
Materials” on page 3. 

• Encourage students to observe “good faith” efforts when viewing copyrighted material. 
 
How can I avoid print & display issues with my presentation? 

• The biggest way to avoid printing and display problems for those viewing your presentation is to post 
set your presentation so that it has a white background instead of a “fancy” PowerPoint background.  
The printer will not have to waste toner or memory trying to process and print these background images 
– instead it can focus on processing just the slide content.  More information can be found under Slide 
Design on page 4. 

 FAQs 
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• Another way to avoid printing and display issues is to keep the overall file size of the presentation down.  
FAQ “How can I keep the file size of my presentation as small as possible” (above) addresses file size.  
Presentations that use a lot of graphics should be printed using a PostScript print driver.  Once a 
PostScript driver is downloaded a PostScript printer can then be installed on a computer.  The printer 
vendor’s website should have a PostScript driver available for download. 

• If converting to your presentation to a PDF make sure to convert set the background as white instead of 
using one of PowerPoint’s colorful backgrounds.  If you convert the document to a PDF without first 
removing the colorful background then the person printing it will not be able to print it with a white 
background. 

• Another way to avoid some printing and viewing issues is to ensure that the file has an acceptable file 
nomenclature.  Files that contain long names will sometimes get hung up in blackboard as well as some 
machines will truncate long names including the file extension.  More information can be found on page 
2 under File Nomenclature as well as the FAQ - What will happen if I forget to add the .ppt extension to 
the end of my PowerPoint presentation (above). 

• Please see FAQs “How do I above creating a document that someone will be unable to open” (above) & 
“How can I keep the file size of my presentation as small as possible” (above) for other helpful tips. 

 
Using Microsoft Office 2007 & Windows Vista – How can I ensure people using an earlier version of 
Office will be able to open my presentation? 

• Office 2007 uses a new default file format which is different than previous versions of Office. 
• To ensure people using a version of Office previous to 2007 save the files in the 97-2003 file format. 
• Users can download an add-in for older versions of Office to open 2007 documents but this has to be 

located, downloaded, and installed from the Microsoft website. 
• For detailed information on this issue - please see File Nomenclature on page 2. 
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